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QUESTION NO: 1 
 

You are a desktop support technician for your company. All client computers run Windows XP

Professional. All users use Microsoft Internet Explorer as their Web browser.

 

A user reports that he recently ran Internet Explorer on another user's computer. When he began

to type an address of a Web site in the Address bar, Internet Explorer would automatically

complete the entry he typed in the Address bar. The user requests that this feature be enabled on

his computer as well.

 

You need to ensure that when the user types an address of a Web site in the Address bar, Internet

Explorer attempts to automatically complete the entry for him.

 

What should you instruct the user to do in Internet Options in Control Panel?
 

A. Select the Use inline AutoComplete check box on the Advanced tab.

B. Select the Show friendly URLs check box on the Advanced tab.

C. Disable the Do not search from the Address bar option on the Advanced tab by selecting the

Display result, and go to the most likely site option.

D. Increase the number of days to keep Web pages in the History folder on the General tab.
 

Answer: A
 

Explanation:

Inline AutoComplete completes entries in the Address bar as you type (based on entries you have

used before) and offers a list of choices under the Address bar for other links that start the same

way. You can enable Inline AutoComplete using the Advanced options of Internet Explorer by

following these steps:

1. Open Internet Explorer, and from the Tools menu, select Internet Options.

2. From the Advanced tab, scroll down to the end of the Browsing section.

3. Select the Use Inline AutoComplete check bos . Click OK.

 

 

QUESTION NO: 2 
 

You are a desktop support technician for your company. All client computers run Windows XP

Professional.

 

A user in your company wants to install Microsoft Office XP Professional on her new computer.

She runs Office setup. However, the setup fails and rolls back the installation.

 

You need to re-run Office setup on the user's computer and observe the installation process.

 

What should you do?
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A. Remotely stop and restart the Windows Installer service on the user's computer. Use the

Windows Installer command-line utility on your computer to rerun Office setup.

B. Instruct the user to visit the Microsoft Office Product Updates Web site, and to select the option

to scan the computer for updates.

C. Connect to the user's computer by using Remote Assistance. Instruct the user to remove Office

by using Add or Remove Programs in Control Panel. Use the Add and Remove Programs

application on your computer to run Office setup.

D. Connect to the user's computer by using Remote Assistance. In the Remote Assistance

window, rerun Office setup by connecting to a network-based installation point and double-clicking

the appropriate .msi file.
 

Answer: D
 

Explanation:

To try to recreate the error you have to run the installation in the users privileges so running the

installation on your computer with your privileges will not help you to solve the problem. Visiting

the Microsoft Office Product Updates Web site will not help the user in any way as long as he

doesn't have Microsoft Office installed on his computer.

 

 

QUESTION NO: 3 
 

You are a desktop support technician for your company. All client computers run Windows XP

Professional. The network consists of a Windows 2000 Active Directory domain.

 

A department manager reports that some of the files on drive D on her computer were deleted and

other data was modified.

 

You need to track when unauthorized users attempt to modify or delete data from drive D on the

manager's computer.

 

What should you do first?
 

A. Configure the security access control list for drive D on the client computer to audit the

Everyone group.

B. Run thegpupdate command on the client computer.

C. Run thesecedit command on the client computer

D. Configure the access control list for drive D on the client computer to assign the Deny - Change

permission for the Everyone group.
 

Answer: A
 

Explanation:
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You must track unauthorized attempts to modify or delete the files so auditing the everyone group

is the correct choice.

 

 

QUESTION NO: 4 
 

You are a desktop support technician for your company. All client computers run Windows XP

Professional. All users use Microsoft Internet Explorer as their Web browser.

 

A user reports that when she tries to purchase an airline ticket online, she receives the following

error message: "Cannot load the page, please contact your system administrator."

 

You discover that she can access other sites without receiving the error message.

 

What is the most likely cause of the error?
 

A. The network connection is faulty.

B. Port 443 (HTTPS) on the firewall is disabled.

C. The TCP/IP stack has been corrupted.

D. Port 80 (HTTP) on the firewall is disabled.
 

Answer: B
 

Explanation:

He is on a secure web site purchasing airplane tickets. Thus port 443 (https) closed on the firewall.

 

 

QUESTION NO: 5 
 

You are a desktop support technician for your company. All client computers run Windows XP

Professional and Microsoft Office XP.

 

A user in your company uses a computer that runs both Windows 98 and Windows XP

Professional in a dual-boot configuration. The user reports that an application is available on the

Start menu when he runs Windows 98, but it is not available on the Start menu when he runs

Windows XP Professional.

 

You need to ensure that the application will run on either Windows 98 or Windows XP

Professional.

 

What should you do?
 

A. Instruct the user to start the computer with Windows XP Professional running. Instruct him to

create a shortcut to the application's .exe file located in the Windows 98 folder structure. Then
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instruct him to configure the Compatibility mode tab to run the application under Windows 98.

B. Ask an administrator to install the application when the computer is running Windows XP

Professional.

C. Ask an administrator to reinstall the application when the computer is running Windows 98.

Then instruct the administrator to select the option to install for All users during the installation.

D. Instruct the user to start the computer with Windows XP Professional running. Instruct him to

create a shortcut to the application's .exe file located in the Windows 98 folder structure. Then

instruct him to select the Run in separate memory space check box.
 

Answer: A
 

Explanation:

Because Windows XP has no problems reading the Windows 98 partition but Windows 98 might

have problems read the Windows XP partition its better to keep the program in its original place.

Create a shortcut within Windows XP and configure the Compatibility mode to run the application

in a Windows 98 environment.  Although most programs run properly on Windows XP, some older

applications (especially games) that were written for a specific operating system such as Microsoft

Windows 95 or Windows 98 do not work as expected (or do not install at all). When this happens,

install or run the program using one of the available program compatibility options in Windows XP.

Choosing a program compatibility mode for a program allows that program to run in its native

environment, which should cause the program to run properly and perform as expected.

 

 

QUESTION NO: 6 
 

You are a desktop support technician for your company. All client computers run Windows XP

Professional. All users use Microsoft Internet Explorer as their Web browser. The company uses a

DHCP server to assign IP addresses to all client computers.

 

The user reports that when he tries to connect to any Web site on the Internet while he is using his

computer at the office, Internet Explorer displays the following error message: "The page cannot

be found." You discover that he followed instructions from his ISP to make several changes in

Internet Explorer on his portable computer so that he could connect to the Internet from home.

 

You verify that Internet Explorer has the correct proxy settings. You instruct the user to ping a

computer on the Internet by using its IP address. The user reports that he can successfully ping

the other computer.

 

You need to ensure that the user can connect to Web sites by using Internet Explorer on his

computer.

 

What should you instruct the user to do?

Microsoft 70-272: Practice Exam

5http://www.maitiku.com QQ:860424807

http://www.maitiku.com
http://www.maitiku.com


A. Select the Automatic private IP address option button on the Alternate Configuration tab of the

TCP/IP properties page.

B. Use Internet Options in Control Panel to add the URLs of the Web sites he needs to access to

the Trusted sites security zone.

C. Select the Obtain DNS server address automatically option button on the TCP/IP properties

page.

D. Use Internet Options in Control Panel to configure the security level for the Internet security

zone to Medium.
 

Answer: C
 

Explanation:

If the user can successfully reach computers on the internet by using their IP address but not

when using the DNS name (or URL) then it probably is a DNS issue and the correct solution would

be to make sure the DNS settings under the TCP/IP properties page are right (in this case

automatically assigned from DHCP). Changing anything in the Internet Options would not help as

the problem is clearly outside the scope of Internet Explorers settings.

 

 

QUESTION NO: 7 
 

You are a desktop support technician for your company. All client computers run Windows XP

Professional and Microsoft Office XP.

 

A user reports that when he opens a Microsoft Word document, Word does not display a toolbar

that contains the Insert Comment button.

 

You need to ensure that the appropriate toolbar is displayed when the user runs Word on his

computer.

 

What should you instruct the user to do?
 

A. Open a document that was created by another user. Select Shared Workspace from the Tools

menu.

B. Copy a Normal.dot file from another computer to the My Documents folder on the user's

computer.

C. Right-click one of the existing toolbars and select Reviewing from the context menu.

D. Select Detect and Repair... from the Help menu.
 

Answer: C
 

Explanation:

The Insert Comment button appears on the Reviewing Toolbar. Simply enabling this toolbar will

show this button. To enable the toolbar, right click any open spot in the toolbar area. From the
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dropdown list, click Reviewing.

 

 

QUESTION NO: 8 
 

You are a desktop support technician for your company. All client computers run Windows XP

Professional with Service Pack 2 (SP2). The company has a main office and a branch office. The

branch office is connected to the Internet by a persistent cable modem connection.

 

A user at the branch office reports that she cannot find the log that is generated by Windows

Firewall on a computer named Client1. You discover that Client1 is configured to have Windows

Firewall log all dropped packets.

 

You need to ensure that the user can find the log that is generated by Windows Firewall on

Client1.

 

What should you instruct the user to do?
 

A. In Event Viewer, view the system log.

B. Search for and view the Pfirewall.log file.

C. Search for and view the Drwatson32.log file.

D. In Event Viewer, view the security log.
 

Answer: B
 

Explanation:

If you search the help on your local computer for ICF. Then view security log file you will see

pfirewall.log file. This is the default name for the firewall.log, which is located in the Windows

folder.

 

 

QUESTION NO: 9 
 

You are a desktop support technician for your company.

 

A customer running Windows XP Home Edition with an antivirus application installed reports that

he downloaded a program from the Internet and installed it on his computer. After installing the

program, he began to receive e-mail messages from people whom he does not know. These e-

mail messages state that he sent an e-mail message to them. The user removed the program but

he is still receiving the e-mail messages with the same message content from people whom he

does not know.

 

You need to identify the cause of these e-mail messages.
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What should you instruct the user to do?
 

A. Download the most recent virus signature files and scan his computer for viruses.

B. Run the Security Configuration and Analysis tool and analyze his computer by using the

hisecws.inf security template.

C. Run the Microsoft Baseline Security Analyzer (MBSA) tool and scan for security updates.

D. Connect to the Microsoft Windows Update Web site and scan his computer.
 

Answer: A
 

Explanation:

Update the anti virus software on the computer because this is some type of worm virus spread

through email.

 

 

QUESTION NO: 10 
 

You are a desktop support technician for your company. All client computers run Windows XP

Professional with Service Pack 2 (SP2) and Microsoft Office XP.

 

A user installs a new printer in his office. He wants to share the printer with his administrative staff.

He has no difficulty printing, and Print Sharing is turned on. The staff still cannot print on the

printer.

 

You need to ensure that the user can share the printer.

 

What should you instruct the user to do?
 

A. On the user??s computer, right-click the printer, and click Properties. On the Advanced tab,

click Print directly to the printer.

B. On the user??s computer, right-click the printer, and click Properties. On the Advanced tab,

click Always available.

C. Download the latest printer drivers from the Internet and install them.

D. In Security Center, click Windows Firewall. On the Exceptions tab, select File and Printer

Sharing.
 

Answer: D

 

 

QUESTION NO: 11 
 

You are a desktop support technician for your company. All client computers run Windows XP

Professional.
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A user reports that macros that previously worked in Microsoft Excel do not run after she installed

Windows XP Service Pack 2 (SP2). The user receives the following error message: ???Macros in

this workbook are disabled because the security level is high, and the macros have not been

digitally signed or verified as safe. To run the macros, you can either have them signed or change

your security level. Click Help for more information.???

 

The user wants to configure Excel to automatically run macros that are included in spreadsheets.

 

What should you instruct the user to do?
 

A. In Excel, on the Tools menu, click Protection, and then select Allow users to edit ranges.

B. In Excel, on the File menu, click Permission, and then select Unrestricted Access.

C. In Excel, on the Tools menu, click Options. On the Security tab, click Macros Security, and then

set the macro security level to Medium.

D. In Excel, on the Tools menu, click Options. On the Security tab, click Macros Security, and then

set the macro security level to Low.
 

Answer: D
 

Explanation:

Office XP offers three levels of macro security - High , Medium , and Low . By default, all Office XP

applications are installed with the macro security level set to High , which means that if a user

opens an Office document that contains suspicious macros, Office disables the macros before

opening the file. (A suspicious macro is any macro or other executable code that has not been

digitally signed by a certified source.) If the security level is set to Medium , users are warned

when a document contains suspicious code, but they can choose to open the file and run the

macros anyway. If the security setting is set to Low , no security check is performed.

 

 

QUESTION NO: 12 
 

You are a desktop support technician for your company. All client computers run Windows XP

Professional with Service Pack 2 (SP2) and Microsoft Office XP. All users use Microsoft Outlook

as their e-mail client.

 

A user reports that she receives automated response e-mail messages stating that she sent an e-

mail message. She knows that she did not send an e-mail message. She also states that in the

past day she received a message from every e-mail address in her Outlook Contacts folder. You

verify that other users experience this same problem.

 

You need to identify what causes the user??s computer to automatically send e-mail messages to

all the e-mail addresses in her Outlook Contacts folder.

 

Microsoft 70-272: Practice Exam

9http://www.maitiku.com QQ:860424807

http://www.maitiku.com
http://www.maitiku.com


What should you instruct the user to do?
 

A. Enable Windows Firewall, and on the General tab, select Don??t allow exceptions.

B. In Security Center, enable Automatic Updates, and restart the computer.

C. In Security Center, ensure that virus protection is monitored, and run an antivirus application

D. Run Network Diagnostics.
 

Answer: C
 

Explanation:

The computer has probably been infected by a e-mail worm (virus) that uses the Outlook address

book to find new potential victims. Recently some viruses also uses a random address from the

address book as a faked sender to draw attention away from the actually infected computer but

the right thing to do here is to run a full antivirus scan of the users computer to verify if it is here

computer sending the messages or if it is a other computer sending them in her name.

 

 

QUESTION NO: 13 
 

You are a desktop support technician for your company.

 

A customer running Windows XP Home Edition and Microsoft Outlook Express reports that he

cannot access previously saved e-mail messages. You verify that there are no e-mail messages

when the customer opens Outlook Express.

 

You need to ensure that the customer can access his previously saved e-mail messages.

 

What should you do?
 

A. Search for files with the .dbx file extension. Import the e-mail messages from the .dbx file.

B. Import the e-mail account configuration settings into Outlook Express.

C. Search for files with the .pst file extension. Import the e-mail messages from the .pst file

D. Import the Internet account settings into Outlook Express
 

Answer: A
 

Explanation:

The probable cause for this problem is that the user is not loading his dbx files when Outlook

Express launches.  This is usually due to the user moving the dbx files, and Outlook Express can

no longer find them.

 

 

QUESTION NO: 14 
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